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Abstract. Cultural Arts Education has a role in personal formation or attitude and mentality of children in life, because arts and 

culture education focuses on needs child development in achieving emotional intelligence and social intelligence. Intelligent 

emotional is achieved by self-actualization through a sense of feeling to increase sensitivity and appreciation for the subtlety and 

beauty of art and culture, as well as for competence express it. Social intelligence is achieved through fostering and fostering 

relationships reciprocal empathic and sympathetic democracy towards Indonesian culture and uphold high human rights in order to 

respect diversity in society and the state as well having a national perspective with awareness of the rights and obligations of citizens.. 
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I. INTRODUCTION 

Indonesia is a beautiful country that has the nickname 

"emerald equator". Consisting of thousands of islands spread 

from Sabang to Merauke. Each island has a province that 

has arts and culture that are very unique and interesting to 

know. 

Cultural Arts Education has a role in the formation of 

personal or attitudes and mentality of students in life, 

because cultural arts education focuses on the developmental 

needs of children in achieving emotional intelligence and 

social intelligence. Emotional intelligence is achieved by 

self-actualization through a sense of feeling to enhance 

sensitivity and appreciation of the subtlety and beauty of art 

and culture, as well as the competence to express it,  

Social intelligence is achieved through fostering and 

fostering empathic and sympathetic democratic relations of 

Indonesian culture and upholding human rights in order to 

respect diversity in society and the state and be nationally 

minded with awareness of the rights and obligations of 

citizens. 

Noting this, it is necessary to conduct scientific 

research to find an alternative media for learning arts and 

culture that can facilitate the community, especially students 

to be able to know, understand, and study Indonesian art and 

culture, and also be able to attract students to know the 

diversity of arts and culture Indonesia, so that the 

introduction of art and culture is no longer a boring thing for 

students. 

This learning media will later be useful for students 

in preserving cultural arts in Indonesia. This culture in 

Southeast will be increasingly lost and eroded by time. 

Because of that, it is necessary to foster a sense of pride 

towards the motherland. This cultural introduction is 

presented in the form of maps and animations with attractive 

displays so that students are motivated to learn and make it 

easier to understand cultural arts and culture starting from 

traditional houses, tribes, and traditional tools, all of which 

are introduced in the form of animation. Because basically 

animation is one of the entertainment media which all 

children really like. (Googling animation function on 

learning media for students. This is like the findings in 

research Novita and Anggun [1] which found that video 

animation media improves student learning outcomes. 

Likewise with the use of learning media researched Novita, 

Windiyani, and Fazriani [2], suggests the need for the use of 

media that can motivate students in the learning process 

Research on the use of animation and multimedia carried out 

Nurmayasari [3] suggests that it can be in the form of 

recording images, sounds, images, films or videos and 

animation which is a potential material to explain a method, 

axioma, theory or formula that often very complex that is 

difficult to teach and learn.In the meantime research Sutisna 

and Novita [4] suggests the importance of ICT in 

learning.Thus the introduction of art learning can be planned 

in introducing a media based on macromedia flash.  

The concept of learning media is often interpreted as 

a tool. This is in accordance with the understanding put 

forward by Riyana [5] that learning is a tool that can 

motivate students in learning. Meanwhile Sadiman [6] 

explained the learning video that displays pictures and 

sounds. The message presented can be in the form of facts 

(events, important events, news) or fictitious (such as 

stories), can be informative, educational or instructional. 

Next Joseph, at.al. [7] proved the influence of the use of 

interactive multimedia used by teachers in teaching. 

Thus it can be interpreted that the opinion of the 

media helps in conveying material that is difficult to convey 

and difficult for students to understand. Making media with 

good planning, will produce a more interesting form of 

media and of course will be able to motivate students in 

learning, so that the results of learning can increase. 
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II. RESEARCH METHODS 

The research method used is the method of 

developing multimedia, namely concept, design, and 

material collecting, assembly, testing, and distribution [8].  

After determining the theme to be made, the next thing to do 

is to determine the title of learning media. After the theme 

was chosen, the author finally chose the title of the type of 

learning media with the title "Introduction to Indonesian Art 

and Culture". In this learning media, a map of Indonesia will 

be displayed where there are several stages. At each stage 

there is a map of Indonesia and the provinces with their 

respective characteristics in the province.  

In designing the learning media contents all ideas 

and concepts that have been planned are outlined to create 

this multimedia system. The content design stage is also an 

implementation of the creative ideas we have. Designing 

content includes evaluating and selecting message appeal, 

style in executing word messages (themes). In executing this 

learning media message consists of several parts, including: 

1) The Initial / Start: The initial part of the learning media 

consists of background and loading, 2) Main Menu: After 

loading, the main menu consists of three menus, 3 ) Sound: 

The part after the Settings button is clicked. In this section, 

the player can set the sound on this learning media, and 4) 

Start: Is the part where the learning media is started, this 

section consists of 3 views, namely: a) First look: 

Indonesian map image, b) Second display: Indonesian island 

image, and c) Display Third: contains the province along 

with Indonesian arts and culture and existing knowledge in 

the province. 

Assembly, the assembly stage is the stage where all 

multimedia objects are created. Making an application based 

on a storyboard, flowchart view, or object diagram that 

comes from the design stage. After the data is collected, the 

whole creation phase is made in Macromedia Flash 8 

software. 

Testing (Trial), after doing the assembly phase, the 

next stage is the testing phase. Testing phase where all data 

is entered. The trial process is classified into 3 (three) 

categories, namely: 1) Structural Trial, a trial is made to find 

out whether the system has been well structured and the 

navigation process made has worked well, according to 

what was designed at the beginning of the study also 

adjustments on interface and layout design. 2) Functional 

trials are conducted to find out whether the application made 

is able to function properly or not. 3) Validation testing, a 

trial process is carried out to ascertain whether the system 

logic functions are running properly and properly. 

Distribution (Distribution), at this stage, the 

application has been created and stored on storage media 

such as a flash disk or CD. This is done to introduce the 

application and also evaluate the media that has been built. 

Design Process Stage: Making Concepts consists of 

1) setting goals, at this stage the objectives of multimedia 

are determined, as well as the audience using them. The 

purpose and audience influence on the multimedia element. 

as a reflection of identity that wants information to reach the 

audience. 2) understand the user's character, in this case the 

majority of the audience likes the pictures, animations, and 

sounds that appear. So it does not make the audience get 

bored quickly and create a more effective learning process. 

The good side of the audience will be more focused in 

learning the introduction of Indonesian art and culture. This 

program is designed to help the audience especially students 

in the learning process and facilitate the application of 

material with video and audio animation systems. 

 

Table 1. Description of Concept Design 

The object Description 

Title Learning Media 

Audience Introduction to Indonesian Art and Culture 

Duration General 

That image - 

used Use JPEG format 

Audio used and PNG 

Video Music Instrument mp3, 

used Sound effect.wav, Voice narration. 

 

Navigation structure, nn designing this learning 

concept using a navigation structure, this is done in order to 

facilitate the preparation of pages on the main menu.  

Character adaptation stage, at this stage a sketch of 

"Si Bolang" is a character on Television. The purpose of 

taking this character is because Si Bolang is an adventurous 

animated character. After this character is scanned then 

convert the file so that editing can be done on the image. At 

this stage it is done using the SAI Pain Tool software. The 

steps are as follows 1) Open the SAI Paint Tool program 

through the start menu, 2) Select File then select Open, 3) 

Then enter the file that has been scanned, 4) Select the 

Layer menu then select New Vector Layer, 5) Then select 

the Curve tool to draw a line and adjust it to the scanned 

image. 

Image Editing and Coloring The editing and coloring 

of images using Adobe Photoshop CS3 software. This stage 

is done so that the image or object that has been drawn 

before look more real and attractive. The steps are as 

follows: 1)  Open the Adobe Photoshop CS3 program via 

the start menu, 2) Select File then select Open, 3) Then enter 

the resulting file from sketching in the SAI Paint Tool 

software, 4) Select the Layer menu then select New Layer to 

create a special color layer for the object, 5) Then select the 

Magic Wand tool to make a selection of the part that will be 

colored, and 6) Then select the paint bucket tool to give 

color to the object. 

User Interface Development Stage, at this stage is the 

stage of making the user interface that is created using 

Adobe Photoshop CS3, the following steps are the steps: 1) 

First of all open Adobe Photoshop cs3, Select new file, 2) 

Set the canvas size by changing the width of 1044 and the 

height of 560 pixels, 3) Select the Open file, select the 

image we want, like the map of Indonesia, then Open, 4) 

Drag the image into the blank canvas, 5) Adjust the size of 

the map image to match the size of the canvas by clicking 
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the Edit menu, select Free Transform or by pressing Ctrl + 

T., and 6) Arrange the map image as we want. 

Voice Narration Making, using audacity software. 

The voice created is a narration of an explanation of how to 

use the learning application, the following steps are for 

making the sound narration: 1) Prepare a micropone 

headseat, 2)  Open Audacity, 3) Click Append Record, 4) 

Click File -> Export, 5) Type the name of the file then click, 

and 6) Save.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure1. Display Development Image 

 

 
III. RESULTS AND DISCUSSION 

The results of research and discussion are presented 

on the results of the display form along with explanations - 

explanations about the pages of the learning media 

applications that have been made. 

1. Start Page Intro 

The intro page is designed to explain that the 

application user has entered the learning media 

opening page. In this intro scene there is a black 

background, a picture of a book with motion tween and 

sound effects, animated text coming out of the book 

with a motion tween effect and sound effect, a button 

that reads skip with sound effect. 

On this page animated text appears from small to large 

and some text appears rotating. The manufacturing 

technique is by giving motion tween animation and for 

the spinning one by arranging the rotation. 

2. Intro page 1 

On this page displays the title of the application. In this 

intro scene there is a table and book background, 

animated text that appears from small to large and a 

paper image that appears spinning with motion tween, 

a button that says skip with sound effect . 

3. Main Menu Page 

On the menu page there are learning points that are the 

initial buttons starting the learning story, there are four 

buttons in this scene in the form of buttons that are on  

the surface of the map of Indonesia, namely the Start 

button, Settings, and the exit icon. In this menu the 

user can choose the start button if you want to start the 

media and Settings if you want to enlarge and shrink 

the screen and the sound button to turn on and turn off 

the sound. Each button or button that is pointed by the 

mouse cursor button size will change to small, this is 

made to distinguish the button that is ready to be 

clicked. As well as music instruments, so the display is 

more interesting in learning. 

4. Page Settings Button 

On this page there is a character and a button to adjust 

the screen, and the sound that the user wants. There are 

several icons such as full screen, small screen, volume, 

and close. 

5. Homepage Selection Island 

This page will begin the beginning of the story of the 

introduction of Indonesian art and culture. There is an 

Indonesian map background with navy blue canvas, 

characters and text. on this page there is also voice 

narration, and sound effects. 

6. Indonesian island page 

This page will begin the process of introducing 

Indonesian art and culture story begins with the voice 

narration by the character and animated arrow button 

and text images, so the character can walk to the island 

he wants to go to. and on this page there are also sound 

effects and voice narration when arriving at the 

destination island. 

7. Province Map page 

On this page tells the introduction of Indonesian art 

and culture from traditional houses, tribes, traditional 

tools as well as the unique facts of the province, click 

on each icon and an explanation of each icon will 

appear. and there is a character as a symbol that he has 

reached the province. It is intended that users can 

really learn and get to know the culture in the province. 

8. Structural Trial 

This stage is carried out to test whether the structural 

that has been made runs according to the design.From 

all the tested pages, the entire page structure is in 

accordance with the design. 

9. Functional Trial 

After structural testing, functional testing is then 

performed, which is done by clicking on each button 

and looking at the page that the user is aiming for, the 

functional test results can be seen in the table below. 

 

 

 

 

 

 

 

 

 

 

 

Character Adaptation picture coloring 

User interface creation Voice Narration Making 
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Table  Functional Trials 

 
No Scene Button Function or not 

1. 

 
Main Menu page 

 

 
 

 

 
Function 

2. 

 
Page Settings button 

 

 

 

 

 

 

Function 

3.  

 

 

 

 

Island Selection Page 

 

 
 

 

  

Function 

4. 

 
Map of the Province page 

 

Function 

 

Based on the results of functional trials, the 

navigation structure and validation of each page goes 

well. 
 

IV. CONCLUSION 

The conclusions that can be obtained from this 

research are as follows: 

1. This learning media is designed using multimedia 

development methods and graphic design. 

2. This learning media provides a menu of material to help 

students understand material about the introduction of art 

and culture 

3. This learning media introduction to art and culture 

provides info about traditional houses, tribes, traditional 

tools and unique facts that exist in each province. 

4. This Learning Media is declared valid by means of a trial 

run. There are three stages of trials that must be carried 

out, namely, structural trials, functional trials, application 

trials so it is feasible to be disseminated in general. 

5. Making this learning media using Macromedia Flash 8 

software. 

Suggestions for further development is to add 

additions to the main menu such as games ,. And on each 

page the island is given animations and sound effects in the 

provinces visited, so students become more interested and 

interactive. 
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